MEDIEVAL ARCHAEOLOGY - INSTRUCTIONS FOR AUTHORS

Medieval Archaeology welcomes original submissions of international significance, or national
significance and of international interest, which match the objectives of the Society. We seek to
support and advance the international study of the archaeology of the period from the 5th to the 16th
century AD. While we maintain a special concern for the medieval archaeology of Britain and Ireland,
we also provide a forum for the discussion of important finds and developments within this period from
anywhere in the world, serving as a medium for co-ordinating the work of archaeologists and that of
historians and scholars in any other discipline relevant to this field. All contributions are subject to

peer review.
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Editorial and publishing process

We welcome articles and shorter contributions that present novel interpretations, applications of an
analytical method or present new findings (see Martyn Jope Award). As a guideline, normally papers
will not be longer than 12,000 words including notes and bibliography, although there will be
exceptional circumstances, including when a grant is available to support publication. A ‘shorter
contribution’ will tend to be in the region of 57,000 words. (For items that are shorter than this,
consider sending these to the Newsletter Editor; see below for details).

We also welcome offers of reports for the fieldwork highlights section and offers of reviews (see

below).
Contacting us

Articles and Shorter Contributions
Hon Editor

Dr Sarah Semple

Department of Archaeology

Durham University

South Road

Durham DH1 3LE
s.j,semple@durham.ac.uk

Tel +44 (0)1913341115

Deputy Editor
Dr Aleksandra McClain
Department of Archaeology, University of York

Books for Review

Reviews and Medieval Britain and Ireland
Editor

Dr Neil Christie

School of Archaeology and Ancient History,
University of Leicester, University Road,
Leicester LE1 7RH

njcl0@leicester.ac.uk

Tel + 44 (0)116 2522617

Reports for Medieval Britain and Ireland, including
Highlights

England, Scotland and Wales and the islands

Tiziana Vitali

9 Cranfield Road

Brockley Cross

London

SE4 1TN

tvitali@pre-construct.com

Tel +44 (0)181 780 3205

Ireland
Tomas O Carragain
Department of Archaeology

Newsletter items

Newsletter Editor

Dr Niall Brady

The Discovery Programme
34 Fitzwilliam Place

Dublin 2

Ireland
Niall@discoveryprogramme.ie
Tel +353 1 639 3722



mailto:njc10@leicester.ac.uk
mailto:tvitali@pre-construct.com
mailto:Niall@discoveryprogramme.ie

University College Cork
Ireland
T.OCarragain@ucc.ie
Tel +353 21 490 4043

Patrick Gleeson

Department of Archaeology
University of Newcastle

Newcastle upon Tyne, UK, NE1 7RU
Patrick.Gleeson@newcastle.ac.uk

Articles and Shorter Contributions

Our editorial cycle
Submissions are considered by the Editors as soon as they are submitted. The next steps are
normally:

e after a preliminary check for suitability, we send your paper to anonymous referees (normally
two) and ask them to address a series of questions

e assuming provisional acceptance of your paper, we ask you to return your revised text within
3 months.

¢ we will confirm whether we have accepted your revised paper for publication the following
year and which issue we intend to place the paper in.

e over the next couple of months the Editor is likely to contact you with queries or corrections
about the detail of the paper.

¢ we will notify if you are the winner of the Martyn Jope Award

o you will receive proofs in either March or September depending on the issue.

e your paper will be published in either May or November depending on the issue .

Martyn Jope Award

Since 2007, the Society has annually awarded the Martyn Jope Award of £200 for the best novel
interpretation, application of analytical method or presentation of new findings published in its journal.
The Editorial Committee of the Society considers all submitted articles and shorter contributions for
eligibility. Our President makes a presentation at the December AGM, very shortly after publication of
the award-winning paper.

The John Hurst Award for best undergraduate dissertation in medieval archaeology

The Society made its first annual award in 2007. The winner receives up to £100 of Society
monographs of his or her choice. We will consider on a case-by-case basis whether to encourage
publication within the journal. The normal submission process applies. This is also dependent upon
the dissertation supervisor providing guidance on this process, including a check on the quality of the
contribution before its submission to the journal.

Helping each other

It is essential that your submitted contributions strictly follow our guidelines. This is to avoid
unnecessary costs and delays, as well as to ensure the most effective use of the Editor and Deputy
Editor’s unpaid time. For the same reason it is highly desirable that submissions follow the editorial
cycle (see Appendix 2), since the editors do not necessarily have the flexibility or capacity to deal with
late submissions.

If you are uncertain about anything, please ask, since this can help us to improve our guidelines for
others.

Rather than delay publication of the journal, we will return seriously deficient presentations to authors
and may withdraw these.
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Stage 1: contacting us about your proposal

We positively encourage you to contact the Editor to discuss possible contributions or drafts before
submitting a finished typescript, particularly if the proposed contribution is likely to be over 12,000
words. The Editor will send you a Stage One form with a series of questions to address:

outline the proposed paper's content and a working title
state what contribution it makes to the issue or problem addressed (and with reference to the
Society's objectives, including how the subject and its treatment is of international significance
or national significance and international interest) (in the case of an excavation report, what
makes this site so very special)

e indicate the paper's likely word length, including notes and bibliography, and number of tables
and figures

e identify when you plan to submit

e tell us whether or not its publication would be grant-aided (note: such funding is not a pre-
requisite for publication, but there is an expectation that papers resulting from commercial
work undertaken by units and by major public bodies will normally bring funding. This includes
the cost of abstract translations).

We publish very few excavation reports and then only when the site is very special. What this means
in practice is:

e We will only publish material where the story that it tells us is, at the very least, of national
significance and international interest. This means, before writing, having a very clear idea of
the story you are going to tell and the new contribution this will make to the study and
appreciation of medieval archaeology.

e Set out at the beginning of the article what the current research questions are that the
excavation relates to, and how/why this site is significant in addressing these research
questions. The most significant issues should be summarised in the conclusion.

e Have a very clear idea before you begin to write about how to present the essence of the site
and support its story, ie your distilled understanding of it. In reporting, focus on the evidence
that is necessary to support the interpretation (‘story’) that you are telling.

e The other meaningful content, including databases, needs to be acknowledged and
accessible online (eg ADS) so that others can readily access and assess it.

e Consider complementary (layered) publications for further aspects of the site.

¢ You may find an excavation overview better fits Medieval Britain and Ireland and Fieldwork
Highlights (see below).

Other details to consider:
e Write an abstract that sells your story and its significance.
e A picture tells a thousand words and will be more readily remembered — so use images and
their captions to complement rather than duplicate the text,.

Stage 2: Preparing your paper for submission and refereeing

Remember, all submissions must follow our house style. Use the checklist (Appendix 3) to ensure
what you are submitting is complete and of the highest order. Please submit the following:

Text
Please submit a single electronic file containing the following:

e Preliminary page: title of paper, name of author(s), short institutional affiliation of each
author, abbreviated title (for running headlines within each article), word count of the article
and, at the bottom of the page, full name and address to which all correspondence should be
sent, including email address

o Title

e By [author(s)] (Address then <email> of author(s) to appear in italic as first of notes; separate
note for each author)

e Abstract (in italics)

e Text [Do not include an Introduction heading, since it will be obvious what this is]

e Appendices [incorporate references into the Notes and Bibliography for the whole article]
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e Bibliography
- Abbreviations
e Acknowledgements
e Grant acknowledgement: This paper is published with financial assistance from [name of
sponsoring body]
List of figure captions
List of table captions
o Notes (when published, we convert your submitted endnotes to footnotes, but you submit
them as endnotes because they are easier for us to check). Please create your endnotes
using the automatic note function rather than inserting subscript numbers, etc manually.
Text must:
have margins of at least 1 inch (2.5 cm) on all sides.
be fully 1.5 in spacing.
12 pt font throughout (10 characters to the inch)
indent beginning of all paragraphs one tab stop.
have numbered pages.
have no running headers or footers.
be submitted electronically as either MS Word (by preference) or Rich Text Format.
be justified to the left-hand margin only.
have hyphenation function to OFF and no words broken over line ends (Hint: Format >
Paragraph > Line and page breaks > Don't hyphenate).

It is essential that the text files be as free of extraneous formatting codes as possible. Use italics only
for sections of the article that are to appear in italics in the printed version. Bold text may be used
where required, eg for the transliteration of runic or ogham inscriptions. Use electronic footnote
functions.

Distinguish headings and subheadings as follows:
e subhead A, caps, centred
e subhead B, small caps, range left
e subhead C, upper and lower case italic, range left
e subhead D, upper and lower case roman (ie normal text), range left

Submission: Medieval Archaeology now operates an online submission system via Editorial
Manager. You should register as an author and submit your paper via Editorial Manager:
http://www.editorialmanager.com/med/default.aspx. This system will allow you to record your author
details and to upload your paper in MS Word with accompanying images. The system will generate a
.pdf of the paper for the referees.

Should you encounter problems please use the contact details for the Editorial Manager system direct
in the first instance. Should submission prove particularly problematic then contact the Editor for
assistance. You may email your contribution or post it on a disk. We will let you know if we also need
your contribution in hard copy (up to two copies).

Captions

As text, but please list captions for figures and tables separately. These must cite names of
photographers and illustrators, and any copyrights and permissions. Ensure that there is a reference
within the body of the text to each figure or table.

Please supply captions for your illustrations as below, noting particularly the details of punctuation
and the other abbreviations used.

FIG 3

The Hunterston Brooch.

(a) Reconstruction of the central feature. Scale 1:1. (b) Detail of an edge pattern on the pin
head. Scale 4:1. Drawing by A N Other. © xx [if different].
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FIG 4

Details of the Hunterston Brooch.

(&) Junction of the hoop and terminal. Scale 2:1. (b) General view. Scale 1:2. Photographs: a,
National Museum, © xx [if different]. b, A N Other, © xx [if different].

Tables
As text, but supply a separate electronic Word file for each table, Note page size when preparing
tables (see illustrations, below).

Figures (drawings and photographs)

In the first instance, you may upload your figures as .jpgs, tiffs, eps files or as good quality pdf files for
the editors and referees to use. We will let you know if we need hard copies at this stage. If you are
unable to supply in electronic format, send the Editor two sets of hard copies (plus the tiff or jpg files
on a disk, where applicable). Ensure it is clear which figure is which. Only once we have provisionally
accepted your paper will we ask you to submit your high resolution digital images. Let us know at an
early stage if you are not able to submit images digitally.

It is particularly important for electronically supplied images that there is a printout indicating any
cropping and adding the figure number for identification.

Figures must:

e be a good design and quality.

e be a high standard for reproduction.

e be supplied as pre-designed composite image, where applicable (ready mounted when hard
copy — see below).

e include north point and metric scale (in maps a scale in kilometres is preferred).

¢ include a metric scale in all artefact illustrations to avoid error in reduction if a proportional
scale only is given and/or, where sizing of images is crucial, provide either a total width or
total depth dimension, not 'size as supplied' or indicate the size of one element of the total
image.

e on scales, remember to include a space between measurement and unit of measurement, ie
‘5 m’ not ‘5m’.

We expect you to submit digital images. If this is not possible, please liaise in advance with the Editor.
Electronic images must:

e beintiff, jpg or eps format (if at correct resolution).

¢ have minimum scanning resolution of 1200 dpi for fine line drawings (800 dpi for simple
drawings); 350-400 dpi for half tones and 300 dpi for colour images.

e be supplied as CYMK not RGB, if colour images.

Please supply all images in colour (where applicable) as well as black and white. This is to ensure no
loss of contrast if we have to print in black and white. Line work and maps are normally reproduced in
the journal in black and white unless colour is unavoidable and there has been prior discussion with
the Editor, but it may also be necessary to print some photographs in black and white too. All images
submitted in colour will appear in colour in the online version of the journal.

We advise authors to print out all images supplied electronically before submission, so that you can
assess the hard copy image for contrast etc rather than the image on screen. You may need to adjust
contrast at this stage. It is also useful for you to see the image printed at approximately the size you
wish it to appear - what might be clear and legible on a full computer screen will not be the same
printed out at journal text width or less.

Bearing in mind that space in the journal is always limited, make economical but well-designed
use of the available page size, taking into account that the printers can place captions above and
to one side of the figures. In working out sizes for figures, remember that the maximum area
available in the journal for any one figure or plate is 200 mm by 135 mm. However, the optimum
area is 190 mm by 135 mm, to allow appropriate space for captions and other necessary printed
details.



e Use the captions and not the artwork for the title of figures. Consider too whether your
key can go in the caption. Large scales waste space so please tuck them into empty
corners. Design to avoid unnecessary areas of blank space.

e We only accept figures and tables requiring foldouts in exceptional cases.

e In composite figures, place the drawings (already mounted) as closely as possible
together, remembering that, on reduction, they will appear further apart. Do lettering and
numbering of items on figures before submission to us. Take care to ensure that the
letters and numbers are sufficiently clear and large to be distinctly legible when reduced.

e Only give imperial measures for the illustrations of features or smaller objects if there are
special historical reasons for doing so.

o Number the copies of figures provided in pencil on the back to correspond with the caption
numbers.

e We strongly advise you to retain copies of all illustrative material. Once your paper is
accepted, you must supply the Editor with electronic images that meet the required
specification (see above) or, in exceptional circumstances, your original drawings.
Photocopies, etc are inadequate for reproduction purposes.

Please note that we do not normally return submitted materials.
Confirmation of copyright and permissions

The lead author is responsible for ensuring that all copyrights are correct and that the necessary
permissions are in place. Taylor and Francis our publisher, will ask you to sign a copyright form near
to publication (this will also address the copyright of the paper to be published in Medieval
Archaeology).

Stage 3: submitting your revised paper for publication

After the Editor has notified you that your paper has been provisionally accepted, and once you and
the Editor have mutually agreed the changes required, you submit a revised version of the article, as
Stage 2, plus final (electronic) versions of figures (should important: double-check images on disk are
in correct format - see above).

Stage 4: checking your proofs

We email you proofs as pdf files (to the nominated lead author, if there is more than one of you). We
supply these for checking and making essential typographical corrections. You must normally post
corrected paper copies of proofs to the Editor within one week of receipt. We do not normally accept
revisions, alterations or changes to text or illustrations at this stage. If you require any extra changes,
you must agree them with the Editor, but you may incur the publisher's costs.

Stage 5: publication of your paper

You receive a free pdf file of your paper. Taylor and Francis will send you a letter with the pdf
explaining how you can use it. For example, you can place pre-prints on your institutional
electronic archives, but not post-prints or the final published version. You will also be able to
order digitally printed offprints from TandFat the time you check your proofs. (Note: the pdfs you
receive will be low-resolution, suitable for on-screen viewing).

Medieval Britain and Ireland - submissions and procedures

Medieval Britain and Ireland is designed to provide a resource of summaries of work carried out each
calendar year across Britain and Ireland. We request entries in journal format from units, museums,
groups, etc for the various county entries. There are two formats: the main one is the online MB&l
hosted by ADS which lists in searchable form all entries (see below); the second is the 'Highlights'
section published in the journal, which are extended overviews of results, finds and contexts.

For the Highlights, contributors are welcome to offer potential extended summaries of up to 2000
words with short supporting bibliography where appropriate, good quality b&w and colour figures (to a
maximum of four — see image guidelines above). The Highlights selection will aim to cover new
evidence illustrating the breadth of medieval contexts and flagging their regional or national
significance. Contributors are welcome to contact the MBI co-ordinators on their proposed texts, but it
is essential to submit full reports by 1 March each year.



MB&I entries of traditional format are required by the end of May each year; a recommended
maximum word length is 750 words; supporting images are welcome. It is essential that all
submissions conform to the journal's house style. From 2008 these entries are housed on an online
directory by ADS and accessible via the Society’s webpages. The facility will also enable contributors
to submit extra pages to support their texts.

For all submissions and queries on submissions, please contact:

British sites
Tiziana Vitali, 9 Cranfield Road, Brockley Cross, London SE14 1TN, UK.
Email: tvitali@pre-construct.com

Irish sites

Tomas O Carragain, Department of Archaeology, University College Cork, Ireland;

Email: T.OCarragain@ucc.ie; papgleeson@gmail.com with Patrick Gleeson, Department of
Archaeology, University of Newcastle, Newcastle upon Tyne, NE1 7RU, UK; Email:
Patrick.Gleeson@newcastle.ac.uk

Reviews - submissions and procedures

Medieval Archaeology annually offers reviews of a full selection of books, editions, excavation
monographs and reports, and other sources, to provide clear summary critical guides to new
published works on British, Irish and overseas medieval archaeology and related studies. We receive
books for review throughout the year from publishers; the Reviews Editor also directly requests them
from publishers.

Reviews are generally short (300 words) or medium length (600) reviews, but longer reviews or
review articles may also be requested (for example, when two or more related publications are
considered). Normally the Reviews Editor seeks reviewers; however, we welcome requests by
potential reviewers. Requests by the Reviews Editor will be for the submission of a review by email
within three months of the receipt of the book. The Reviews Editor will supply the form of the title to
use in the journal and that should appear at the head of the review. It is essential that reviewers
follow the Society's house style because this saves time in preparation for publication; we may return
for correction submissions that do not do this. Please note that in-text references are allowable only
in occasional long reviews.

There are three main submission dates for reviews: mid-October, mid-January, and late March. We
then submit reviews to the publishers in both January and May/June. The Reviews Editor will
undertake any required editing of submissions; only where changes are substantial or for discussion
will reviewers receive edited texts for comment. Taylor and Francis, our publisher, will ask you to sign
a copyright form on receipt of the proof. We do not normally accept revisions, alterations or changes
at this stage.

Medieval Archaeology house style
Writing and presentation style

Think of your reader: make your text digestible and understandable, including for the non-
specialist. Follow the principles of plain English:

e use 'active' verbs (instead of 'passive’ ones) (Hint: Tools > Options > Spelling & Grammar >
Writing style > Grammar & Style - this will underline passive phrases.)

e use a good average sentence length (about 15-20 words)

e use everyday words

avoid turning verbs into nouns or noun phrases, ditto adjectives (Hint: such words often end in

-tion' or '-ness', phrases in '... of')

use first and second pronouns (I, me, we, us, you)

give information in logical order

use lists and bullet points

think of your audience

be personal and polite


mailto:tvitali@pre-construct.com
mailto:T.OCarragain@ucc.ie
mailto:papgleeson@gmail.com
http://www.plainenglish.co.uk/

Avoid unnecessary references. Give bibliographical references only to support factual or illustrative
material or to acknowledge a source, not to justify a particular opinion merely by showing that others
have held it too.

Do not use the ampersand [&].

References

Since Vol 52, the journal has used the Harvard system for articles, shorter contributions and the
Portable Antiquities section of Medieval Britain and Ireland (the very occasional references cited in
the rest of Medieval Britain and Ireland, and the Reviews section, are embodied in the main text). Use
our standard abbreviations (see also below). Within the text indicate references and notes by a
superscript arabic numeral following any punctuation (use automatic endnote functions), and in one
consecutive sequence. In the endnotes refer to publications by author, year and page. Capitalise all
nouns and adjectives in book and journal titles, but only capitalise first word and proper nouns in
article titles.

Examples:

! Hines 2004, 5.

% Barnes and Page 2005, 189; Ritchie, A 1985; Ritchie, G 2001.

® Henderson 2004, 161; 2005, 69—71.

4Clancy and Markus 1995, 135; Hall et al 2005, 293; Hinton 1983.

®> Whitfield 1995, fig 10; Hurst 1964a, pl 13:4; Rod McCullagh pers comm.
® Cf Pestell 2003

" Sykes 2007; 2008; 2009.

® Ibid.

Do not use idem, op cit., passim. In the notes, use et al (not italicised) after the first of three or more
authors. In the bibliography, use et al after citing the first three authors in full. Avoid roman numerals,
unless arabic would mislead. Give complete numerical range of pages cited (not 183-; 183ff; nor
183seq). In footnotes, omit author's initials and 'ed' unless necessary to avoid ambiguity.

8 Eg Ritchie 1994, figs 8-9.
? Note also that Kilnasaggart has encircled crosses on both faces.

Cite primary sources notes by abbreviated location and description, and numbering (if applicable).

°Chron Melrose, xxxiii-xxxiii.

Y PRO PC/1/3/45/9.

List in full all publications listed in Bibliography at the end of the article; likewise all references listed
in the Bibliography must be referred to in the text. Authors are responsible for ensuring these are
accurate. NB: do not inset any references (the publishers require unformatted text and will arrange
this themselves). List references alphabetically by the (first) author and cite them in the following form,
capitalisation, and punctuation:

e Periodical articles
Abbreviate the titles of journals consistently following the Council for British Archaeology's
conventions [Signposts for Archaeological Publication, Appendix A; and in the British and Irish
Archaeological Bibliography], except use Scot for Scotland and Scott for Scottish. This practice
should be extended to journals not included within the CBA's published list of abbreviations, and thus,
as appropriate, to foreign journals: eg Frihmittelalterliche Stud for Frihmittelalterliche Studien.

Anderson, S and Rees, A R 2004, 'The excavation of a medieval rural settlement site at Portmuck,
Islandmagee, Country Antrim', Ulster J Archaeol 63, 76-113.

For parts published separately

Bradley, J 2001, 'Archaeology, topography and building fabric: the cathedral and town of medieval
Kildare', J Kildare Archaeol Hist Soc 19:1 (2000-1), 27-47.

Lelong, O 2003, 'St Trolla's Chapel, Kintradwell: the occupants of the medieval burial ground and their
patron saint', Scott Archaeol J 25:2, 147—-63.



[Space between author's initials. Lower case for title of article. Initial capitals for journal title. Arabic
numerals for volume and part, separated by a colon. Volume number in bold. Use an en rule for
numeric ranges. Only add date of journal in brackets after volume number if the volume covers more
than one year]

Convert all roman volume numbers into arabic.

e Contributions within another author's article
Church, M 2004, 'Summary and discussion of palaeoenvironmental analyses', in D Alexander,
'Redcastle, Lunan Bay, Angus: the excavation of an Iron Age timber-lined souterrain and a Pictish
barrow cemetery', Proc Soc Antiq Scot 135, 41-118, 73-4.

(We do not repeat publication dates within a single bibliographic entry.)

e Monographs
Cramp, R 2006, Corpus of Anglo-Saxon Sculpture, 7. South-West England, Oxford: British Academy.
Gaimster, M 1998 Vendel Period Bracteates on Gotland, Acta Archaeologica Lundensia, Stockholm,
Almqvist and Wiksell.
Gilchrist, R and Sloane, B 2005, Requiem: The Medieval Monastic Cemetery in Britain, London:
Museum of London Archaeology Service.
Glassie, H 1975, Folk Housing in Middle Virginia, Knoxville (Tennessee): The University of
Tennessee Press.
[ie Title: sub-title. Initial Capitals for title, followed by Place of publication: Name of publisher. Bracket
US state after place. Omit from name of publisher: Publishers, Co, Inc or Ltd Retain Books or Press.
Volume number in bold]

o Foreign titles
Capitalise following the conventions of the language concerned. When in doubt, give titles exactly as
they appear on the volumes concerned. For non-western European languages, put translations of the
titles in English in square brackets.
Bourke, C 1982, 'Les cloches a main de la Bretagne primitive', Bulletin de la Société Archéologique
du Finistere, 110, 339-53.
Gerrard, C M 2003, Paisaje y senorio. La casa conventual de Ambel (Zaragoza): arquitectura e
historia de las ordenes militares del Temple y del Hospital, Zaragoza: Institucion Fernando el Catolico
(CsIC).
Lunde, @ 1977, Trondheims fortid i bygrunnen: middelaldbyens topografi p& grunnlag av det
arkeologiske materialet inntil 1970, Riksantivaren Skrifter 2, Trondheim: Adresseavisens forlag.
Nicolay, N de 1568, Les Quatre Premiers Livres de navigations et pérégrinations orientales, Lyon:
Guillaume Roville.
Trier, B (ed) 1995, Grabungskampagne Paderborn 1994, Minster: Ardey.
Van Ossel, P (ed) 1999, Les Jardins du Carrousel (Paris). De la campagne a la ville: la formation d'un
espace urbain, Paris: Maison des sciences de 'homme.
Verbeek, A 1967, 'Die architektonische Nachfolge der Aachner Pfalzkapelle', in Braunfels, 113-56.

e Monograph series
Crone, A 2000, The History of a Scottish Lowland Crannog: Excavations at Buiston, Ayrshire 1989-
90, Scott Trust Archaeol Res Monogr 4.
Christie, N (ed) 1991, Three South Etrurian Churches: Santa Cornelia, Santa Rufina and San
Liberato, Archaeol Monogr Brit School Rome 4.
Driscoll, S T 2002, Excavations at Glasgow Cathedral 1988-1997, Soc Medieval Archaeol Monogr 18.
Friell, J P G and Watson, W G (eds) 1984, Pictish Studies: Settlement, Burial and Art in Dark Age
Northern Britain, Brit Archaeol Rep Brit Ser 125.
Rodwell, W and Rodwell, K 1977, Historic Churches: A Wasting Asset, Counc Brit Archaeol Res
Rep 19.
[Spell out acronyms or list in Abbreviations. Omit Place of publication and Name of publisher]

e Chapters in multi-authored books
Higgitt, J 1995, 'Monasteries and inscriptions in early Northumbria, the evidence of Whitby', in C
Bourke (ed), From the Isles of the North: Early Medieval Art in Ireland and Britain, Belfast: HMSO,
221-36.



Thomas, G 2000, 'Anglo-Scandinavian metalwork from the Danelaw: exploring social and cultural
interaction’, in Hadley and Richards, 237-55. [Where Hadley and Richards is cited more than once]
Hadley, D M and Richards, J D (eds) 2000, Cultures in Contact: Scandinavian Settlement in England
in the Ninth and Tenth Centuries, Studies in the Middle Ages, Turnhout: Brepols.

e References to editions and/or translations of ancient authors and sources
In endnote: Adomnan, Life of Columba, Book Ill, chapter 23, 225, in Sharpe.
In bibliography: Adomnan, Adomnan of lona. Life of St Columba, ed R Sharpe, London: Penguin,
1995.
Gildas, De excidio Britanniae, ed and trans M Winterbottom, The Ruin of Britain and Other Works,
London, 1978.
William of Malmesbury, De Gestis Pontificum Anglorum, ed N E S A Hamilton, Rolls Series 52, 1870.
[the author's name (if known), title by which the source is usually known in italics, the page numbers
on which the text occurs in the edition or translation if appropriate, followed by 'in'; the name of the
editor or translator (preceded by 'ed and/or trans' as appropriate, with initials first and then surname),
the title of the edition or translation, if different from that cited earlier, either the place and date of
publication of the edition or translation or the series in which the text, with a comma between them.]

o References with no date
Abbreviate to nd, author unknown to Anon, specific edition to, eg, 2nd edn.
Alcock, Leslie nd, Excavations at Dundurn, St Fillans, Perthshire, 1976-77, University of Glasgow:
interim report.
[No full stop after edn. Do not use superscript letters, eg 2 edn.]

e Multiple publications by author in same year
Distinguish works by an author published in the same year by lower case letter after the year.
' Forsyth 1995a, 10; 1995b, 243.
Forsyth, K 1995a, ‘Language in Pictland, spoken and written’, in Nicoll, 7-10.
Forsyth, K 1995b, 'The inscriptions on the Dupplin Cross', in Bourke, 237-44.

e URLs
End references to works on the Internet with the URL between angle brackets < > and in italics. Cite
within square brackets the date the document was last updated, if this is apparent, or the date when
accessed, if not:
Thomas, G 2005, Bishopstone, East Sussex, <www.kent.ac.uk/secl/classics/Bishopstone.htm> [last
modified 6 October 2005]
Towrie, S 2004, New dig at site of Skaill Viking hoard,
<www.orkneyjar.com/archaeology/snusgar.htm> [accessed 28 October 2006]
For electronic sources, adapt consistently to the above conventions the advice at
<owl.english.purdue.edu/handouts/research/r_mla.html#Electronic>

e Unpublished sources
Bintcliff, J L 2002, Changes in the countryside: a review of the picture from the archaeological surface
survey for settlement history in medieval and post-medieval Greece, Thessaloniki: European
Archaeological Association Annual Conference paper.
Dunlevy, M 1969, Aspects of Toilet Combs in Ireland (Prehistoric to 17th Century) (unpubl MA thesis,
National University of Ireland).
Reynolds, A forthcoming 2006, Anglo-Saxon Law in the Landscape, Oxford: Oxford University Press.
[titles and volume in roman script not italics]

e Spell out acronyms under heading of Abbreviations at end of bibliography.
CSPD Calendar of State Papers Domestic
HMSO Her Majesty's Stationery Office
PRO  Public Record Office (now National Archives), Kew
NAS  National Archives of Scotland
RCAHMS Royal Commission on the Ancient and Historical Monuments of Scotland
WO0SAS West of Scotland Archaeology Service

[Titles of publications in italics. Publishers and organisations in roman.]
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In references to figures or tables in the same volume of Medieval Archaeology use the abbreviations
Fig, Figs, Tab, Tabs (followed by arabic numerals). In references to plates, figures and tables in other
books or journals (including other volumes of Medieval Archaeology), lower case abbreviations 'pl',
'fig' and 'tab’ should be used. In references to illustrations in German publications use abbreviations
such as 'Abb’, 'Taf' and 'Tafn'.

Style details

Hyphens, en rule and em rule (Hint: see Insert > Symbol > Special characters)

A hyphen is used to link words. An en rule is longer and used (without spaces) for ranges, or to
convey a distinction in sense.. Do not use the en rule to replace ‘and' if the word 'between' is used, or
'to" if the word 'from' is used. En rules should be used for numeric ranges. Em rules appear only as a
parenthetical dash (spaces either side). The omission of part of a word is marked by three dots or
Word ellipsis symbol (Insert>Symbol>Special Character>Ellipsis), but be consistent.

Numerals
Write out numbers up to ten; this rule may be waived in sections of text containing substantial lists
of quantified data. But always use arabic numerals for measurements and dates.

Numeric ranges

1-9, 10-17, 104-9, 112-15, 123-5, 241-63, 349-412 (ie only repeat numbers when different, and for
the teen years. In the case of dates, repeat decade numbers, eg 410-15, 1066-1314.Use en rules to
denote numeric ranges.

Measurements

Use metric (m, mm, km, ha, gr, kg). By preference, give lengths in metres or millimetres, although the
use of centimetres may occasionally be justified. When citing imperial or other systems (ft, in), their
metric equivalent should follow in brackets. Leave a space between the number and the unit of
measurement, eg 5 km, 3 in, 12 kg.

For square and cubic measures write cu m, sq km, etc, never mz.‘Square mile’ in text; sq m with
figures.

Hint: <www.simetric.co.uk/> is handy for checking metric-imperial conversions.

Geographical references

Give the names of counties or local authority areas (where the site lies in Britain or Ireland) and
countries (abroad) in brackets after the first reference to each site. In the case of England, cite the
counties resulting from the local government reorganisation of 1974, irrespective of whether or not
they have survived the most recent local government reorganisation. The names of the previous
'historic' counties may follow: eg Bath (Avon, formerly Somerset) (see
<wwuwv.statistics.gov.uk/geography/gazetteer.asp>). For Scotland and Wales, give the names of the
new local authority areas following the most recent local government reorganisation. For Ireland, use
the historical counties. Unless giving very large numbers of references, it is preferable not to
abbreviate county names; the exception is the Irish counties, where 'Co’ is acceptable).

Hint: <www.statistics.gov.uk/geography/admin_geog.asp> will give you an overview of present
administrative regions in the UK. To check which Scottish local counties a specific place or site lies in
use <www.rcahms.gov.uk> (CANMORE or <www.PASTMAP.org.uk> options); English: Pastscape
on <www.heritagegateway.org.uk/Gateway/> was not a reliable source of correct information as of
December 2008, so check with English Heritage if using this; Welsh: Coflein

on <www.rcahmw.org.uk/nmrw.shtml|>.

National grid references
Cite these for all archaeological sites or historic buildings that are central to the publication, as NGR:
two capital letters, space, eastings, space, northings, eg NGR: HY 2394 1234.

Compass directions

Abbreviate compass directions when used adjectively (eg 'the W window', 'the S range'), and longer
compounds (eg to the NNW). Hyphenate when spelling out, eg north-west. Please note that in
geographical designations it is appropriate to use an adjectival form, eg 'southern England' rather
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than 'South England'; only use the specific, capitalised compass point when it is definitely part of a
compound proper noun, eg New South Wales.

A forward slash indicates alignment or axial orientation (eg 'the burial lay on an E/W alignment’).

Except in special cases (eg 'the Roman Empire in the West'), a capital letter should not be used
with the points of the compass used as nouns or adverbially (eg 'the ditch petered out to the
north', ‘we followed the ditch north and south’).

Dates: ranges

AD563x564 describes dates between which a historical event is supposed to have occurred; AD 563-
64 describes the duration of the event. No points in AD and BC, which should also be small caps.
460s not 460's.

Dates: calendrical
18 July 1826, etc.

Dates: centuries

Where you can use them, absolute dates (dates in calendar years or centuries) offer the clearest form
of dating and are therefore to be preferred. You can use a slash to indicate a date-range: '13th-/14th-
century pottery' = pottery dating from the 13th or 14th century. If it is necessary to specify dates as BC
or AD, it is usual practice to write BC after the date and AD before it, eg 55 BC, AD 1066, except in the
case of 'the 8th century AD'. Please note especially the use of arabic numerals for centuries rather
than 'the eighth century'.

Please get your hyphenation right - this is a common error.

Dates: radiocarbon

Unless otherwise noted, cite radiocarbon (14C) dates in the body of the text that are calibrated (cal AD
or cal BC) at 95% confidence (see Bowman, S 1990 Radiocarbon Dating (British Museum Press) and
<cl4.arch.ox.ac.uk/embed.php?File=oxcal.html>.

For all quoted dates, cite lab code. For new dates being published for the first time, give full details of
radiocarbon ages in the form of a single table, identifying, as a minimum, the lab code, the sample
material, the event likely to be dated, a 8 (delta) C13 value, the age in radiocarbon years (BP), and
calibrated date ranges to the first and second levels of probability. Write + [+ underlined] not +/-

Table 1 Radiocarbon dates

' Calibrated dates
Lab code  Sample material Lab age BP 8" C 1-sigma 2-sigma
AA-26244  Cremated human 1655 + 50 - 24.3%0 AD340-428 AD250-530
bone from the cist

The 8"C value may be helpful in identifying 'odd' samples and can be useful in analysing problems in
the interpretation of dates. Where you give dates in calibrated form, identify the particular
calibration programme with reference to a published source of calibration data (eg OxCal v3.5). You
must calibrate BP dates commonly used by natural scientists if the determinations fall within a
calibration curve.

Dates: periods (see also Appendix 4)

It is essential that chronological references in the journal and other publications of the society are as
consistent and unambiguous as possible. For the journal Medieval Archaeology, the medieval period
(Middle Ages) is defined as the period between the end of the western Roman world in the 5th
century AD and the start of the modern period in Europe, most easily defined as the Reformation and
the Counter-Reformation of the 16th century. The term 'medieval' must not be used to refer
specifically to the later Middle Ages (11th century—16th century) in contrast to 'late Saxon', 'early
Christian', 'early historic', 'Viking' etc for the earlier Middle Ages.

We can recognise three major periods in all areas of Britain and Ireland, although their boundaries
may vary in absolute terms from context to context according to specific historical circumstances. The
Early Middle Ages is the period from the end of the Roman period until the Norman conquest of
England and Wales (starting in 1066) and the Anglo-Norman invasion of Ireland (1169). The High
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Middle Ages falls between this period and the Black Death in the middle of the 14th century, and the
Late Middle Ages runs from then until end of the medieval period. We can equally refer to these
periods as the early, high and late medieval periods. We can use the term 'Viking period' of areas and
contexts with a material presence of Scandinavian character between the very late 8th century and the
end of the Early Middle Ages. In western and northern Scotland, you may refer, as necessary, to the
high medieval period as 'late Norse'. The table below gives further chronological terms commonly and
appropriately used of particular areas. Please note the preference for the terms 'early/middle Anglo-
Saxon', but 'late Saxon'.

Please get your capitalisation and hyphenation of periods right for Medieval Archaeology- this is a
very common error.

England Wales Scotland Ireland
ggl;tzncgﬁgfgr;iin (East)/ early Christian early historic early historic
post-Roman (West) or or
early medieval 5th-8th centuries early medieval | early Christian
5th to mid- middle Anglo-Saxon
11th/12th [not middle Saxon]
centuries
9th-mid-11th centuries Viking Viking Viking
late Saxon-Viking
high medieval 1066-12th century 1066-12th century late Norse 1169 to mid-14th
Norman* Norman* century
Anglo-Norman
late medieval To c 1600
mid-14th to mid-
16th centuries

*Applies to first part of High Middle Ages only

Abbreviations

In general, the convention of the journal is to avoid the use of the point, except where this is
necessary to avoid ambiguity. Leave a space after any abbreviation unless a punctuation mark
follows directly.

AD [small caps] Before Christ

BC [small caps] After Christ

¢ [no italics] for circa

cf

ch chs for chapter(s)

Co [County - Ireland only]

ed eds

€g

et al [no italics; do not use in body of text or in bibliography]

etc

figs figs [capitalise when referring to figs within the publication; write out in full when in sentences]
ibid (no italics)

ie [no italics]

illus

in situ (no italics)

no 5 nos 10-11

p pp [only to be inserted in page references to avoid possible confusion]

pers comm

% not per cent

PhD

pl pls [capitalise when referring to pls within the publication]

tab tabs [but write out in full when in sentences]

You cannot assume everyone knows what a chemical symbol is, so explain in an endnote after first
mention.
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Always write 'line’ or 'lines' out in full rather than 'I'or 'lI' for line references.

Hyphenation (for periods, see Appendix 4).

In most cases, you hyphenate compound adjectives: eg '13th-century floor tiles', 'a Viking-Age sword'.
The principal exceptions to this rule are when the compound occurs as a complement after a verb
such as is or become (eg 'These tiles are well made'), and if the first element of the compound is an
adverb ending in -ly, ‘a poorly fired pot'.

Compound nouns should usually only be hyphenated to avoid ambiguity, eg 'brick-kiln' as opposed to
'brick kiln', 're-presentation’ as opposed to ‘representation’. Note, however, that we always hyphenate
some such words by convention, eg son-in-law, great-grandchild, while you can write other frequently
used compounds as a single word, eg spearhead, posthole [but place names].

Post- and mid- are always followed by a hyphen; always hyphenate before -type, eg pottery-type.

Quotation marks

Use single inverted commas; double inverted commas only where inverted commas occur within a set
of single inverted commas. Precede a quote within text (less than ¢ 20 words) by a comma. For long
guotations use the smartquotes function of your word-processor [Tools>Autcorrect
Options>Autoformat as you type>"straight quotes” with “smart quotes”]; precede long quotes with a
colon, inset, don't use quotation marks, and add an endnote at the end for the source of the
reference.

Spellings

Authors should endeavour to follow conventional British spelling practice as closely as possible.
Where this is variable, eg in the case of words ending -ize/-ise, -ization/-isation etc, authors may
follow their own preferred practice, but must be consistent (note: the Editor's personal preference is
for -ise).

Referring to cited authorities

When referring in the text to the names of other cited authorities give their full name, if possible, on
the first occasion: eg Joseph Crabtree, E T Leeds, etc. Thereafter use only the surname, except in the
case of historical figures usually referred to by their full name throughout, eg Florence Nightingale,
Jane Austen.

Personal titles
Please reserve use of academic titles for the acknowledgements. Always give personal titles a
starting capital, eg Duke of Sutherland, King John (but note the dukes of Sutherland, English kings).

Placenames
Follow the current editions of the Ordnance Survey; identify and discuss any significant variations.

Languages

Italicise non-English quotations and accompany with a translation.

Latin phrases adopted into English do not need to be italicised (eg in situ, et al), but use an English
alternative where this is appropriate.

Format of endnotes

Number endnotes consecutively throughout each article. The text of the endnotes (single-spaced)
must appear in a separate list at the end of the text of the article (pagination carrying on from the end
of the article). Use an automatic endnote system. If for some reason this is not possible, put the
endnote numbers within the text in superscript or in distinctive brackets, such as {}.

Normally place the number for a note after the full stop at the end of the relevant sentence. If a
sentence requires more than one reference these should be collected up and given in sequence in
the one note. If, in the interests of clarity, it is desirable to provide more than one note to a single
sentence the numbers should still be placed, as far as possible, after a clause and after the
appropriate punctuation mark.

The format of the note is number without a point, single space, text.
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Appendix 1: Questions we will ask peer reviewers to address

Please address the following questions, assuming that any part of your responses to 1-10 may be
sent direct to the author. Your comments will be treated anonymously, unless you advise otherwise.

1. Is the subject matter and its treatment of international significance, or national significance and
international interest? If yes, in what way? If not, why not?

2. Does the paper present an original and new contribution to the discussion? If so, how?

3. How high is the quality of application of analytical method? Does the paper distinguish itself in this
way?

4. What is the standard of the academic treatment and presentation of the material and does it meet
the standards to be expected of a national, peer-reviewed journal with an international readership?

5. Are the aims and objectives coherent and clearly articulated in the title, abstract and introduction?
Are they followed through to the conclusion? If not, how might they be improved?

6. Are the figures, photos and tables clear, legible and relevant? If not, how might they be improved?
7. Do the references and citations appear to be appropriate and correct?

8. Specifically, how might the author improve the content of any aspect of the paper? (Please use a
form of words that we can send direct to the author and provide an appropriate cross-reference to the
contents of the paper, such as page and paragraph)

9. What do you require to be changed?
10. What do you recommend is changed?
11. Please note any additional comments that you do not want sent to be sent to the author.

12. Conclusions - do you regard the paper suitable for publication in Medieval Archaeology (please
select one option)?

- yes, in its present form

- yes, with minor changes

- no, or only after major modifications

- no, not at all

13. How would you characterise this paper generally (please select one option)?
- excellent
- good
- mediocre
- poor
- inadequate

14. Did you identify any conflict of interest in refereeing this paper? If so, please describe.

15. If the changes required are substantive or of a highly specialised nature, would you be prepared
to re-read the revised paper in advance of publication? - Yes/No

16. Your response will be treated anonymously unless you offer otherwise (authors often appreciate
being able to contact referees for further information).
- I am/am not content for you to release my name and contact details to the author

17. Are you prepared to referee papers for Medieval Archaeology in the future?
e Yes/No

18. If so, an indication of subjects you have a particular interest in will be helpful (please list):
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Appendix 2: Summary of editorial cycle for articles and shorter contributions

At present we have two general deadlines, the end of January and mid-August when we consider
content for the journal for the following year, however, proposals and full papers are welcome at any
point during the annual cycle.

Papers are sent out for review immediately and referee comments are usually returned to
authors within four months with a decision on whether the paper has been accepted or
rejected.

Authors of accepted papers are given 3 months in which to revise their contributions on the
basis of the referee comments and editorial input.

Papers are then edited by the editorial team and returned to authors. Authors are given four
weeks to consider the changes and respond to any queries.

The paper returned by the author is then reviewed again by the editors, abstracts are sent for
translation and the paper is moved into the production cycle and the author notified of the
publication issue and deadlines for proofs and publication.

A decision on the Jope Award is made by December each year.

Once the contribution has been moved into the production cycle with Taylor and Francis the
following deadlines will apply:

Editor and First proofs | Corrections to
Issue no. Deputy Editor P Publication date Publication Month
. g to authors proofs due
submit final copy
1 early Feb Mid Mar Early Apr-16 17-May-16 May
2 early Jul Mid Sep Early Oct-16 16-Nov-16 November
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Appendix 3: Checklist for submission of a contribution to Medieval
Archaeology
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Format of contents

Abstract at beginning of paper, acknowledgements at end
All copyrights and permissions are included in captions
Figures are supplied ready mounted, where applicable
Metric scale and north point on figures

Minimum scanning resolution is 1200 dpi for fine line drawings (800 dpi for simple); 350-400 dpi
for half tones and 300 dpi for colour images

Electronic figures are supplied in tiff or jpeg format
Colour images supplied as CYMK not RGB
Drawings are at appropriate scale for reduction

Endnotes appear in separate list at end of paper (for ease of editing)

Quality
Figures are good design and quality

Figure are of a high enough standard for reproduction

Things to check electronically in texts (including easy checks done with 'edit' and 'find'
facility)

Margins 2.5 cm all sides

Double-spaced

All 12 pt font

(Papers only) Paras indented one tab stop

(Papers only) Headings on own line and follow conventions for different levels of heading
LH justified

Hyphenation and ordinal superscript function set to OFF and no words broken over line ends
Italics and bold only for text to appear in italics and bold in printed versions

Main title: caps and lower case

Consistent use of terminology for periods and capitalisation

XX BC and AD XX

Arabic numerals for centuries (search on 'centur' to check) and use of hypenation when used
adjectivally

Measurements in metric. Lengths in m or mm. If imperial, metric cited in brackets after. Space
between no and unit of measurement.

m mm km ha kg gr ftin
Hyphenation correct; correct use of en and em-rule; and not italicised

Compass directions: abbreviated when using adjectivally. -em for geographical designations.
Limit use of capitalisation.
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.

.

7.
-

c not circa
Write out numbers up to and including ten.
' not “ except for quotes within quotes

Consistent use of -ise or -ize

Other things to look out for in text

Surnames only after first reference to person in body of text

All endnote numbers superscript, consecutive and after appropriate punctuation mark
No points with personal titles

Dates 18 July 1826 format

Pages numbered (notes follow consecutively from article)

County names present and correct (and not abbreviated, except 'Co' for Irish counties)

Things to particularly look out for in endnotes
p and pp only used when to avoid confusion

Fig, Figs, Tab, Tabs, for ref in this volume; lower case for other publications [for German
publications used Abb, Taf, Tafn]

Line or lines not | or |l
No unnecessary references

Correct reference format

Things to particularly look out for in captions

Captions in correct format

Things to look out for in bibliography

All references cited in notes appear in bibliography, and vice versa. There is nothing in

bibliography that is not cited in the notes.

-
-
-

-1 ®

9.
-

Format correct
Abbreviated journal conventions correct

Space between punctuation marks of abbreviations

To check on final printouts
Hierarchy of headings correct/marked

Location of figures, plates and tables marked if not to be sited close to first mention

Check presence/absence in package to Editor

First submission: single electronic file containing texts in correct order; files containing figures; pdf

of figures

Revised submission; text and tables as above; figures (tiff or jpg format, correct resolution) sent

on disk not by email

Appendix 4: How to capitalise and hyphenate periods
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We hyphenate most compound adjectives, but try

to avoid strings of hyphens and hyphens after ‘ly’.

Adjectival use

References to periods/ages/times

late antique

Late Antiquity

prehistoric remains
early/ late-prehistoric encampment
early/ late-prehistoric period jewellery

the prehistoric period
in early / late prehistory
the early / late prehistoric period

early/ middle-/ late-mesolithic carvings

the early / middle / late mesolithic period

early/ middle-/ late-neolithic pottery

the early / middle / late neolithic period

early/ middle/ late Bronze-Age /Bronze-Age crafts

the early / middle / late Bronze Age

early/ middle/ late Iron-Age /lIron-Age weapons

the early / middle / late Iron Age

early/ middle/ late Roman-period customs

the early / middle / late Roman period

Romano-British chronicles

the Romano-British period

post-Roman civilisation

the post-Roman period

medieval music

the medieval period

historic tradition

the historic period

early medieval / early historic / early Christian
cup

the early medieval / early historic / early Christian
period/ the Early Middle Ages

early / middle Anglo-Saxon poetry

the early / middle Anglo-Saxon period

late-Saxon warcraft

the late Saxon period

Viking invasion, Viking-Age object

the Viking period

Saxon-Viking cross [Saxon isn't a prefix]

the late Saxon-Viking period

late-Norse settlement

the late Norse period

pre-Conquest fortification

the pre-Conquest period

Norman helmet

the Norman period

Anglo-Norman churches

the Anglo-Norman period

late-medieval/ high-medieval chapel

the Late / High Middle Ages [in preference to late
medieval period]

post-medieval prayerbook

the post-medieval period

Reformation practice

the Reformation

post-Reformation restrictions

Renaissance architecture

the post-Reformation period

the Renaissance

early-modern

the early modern period

modern times

the modern period

the First World War
the Second World War
the Irag War
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